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Prefazione

Questo è una guida per chi volesse cominciare ad usare Blender. 
Cos'è Blender? Blender è un programma per la modellazione 3d, concorrente dei vari  
Maya, 3dstudioMax, AutoCad, etc....
E' un programma open source, gratuito, utilizzabile su sistemi Unix, Mac e Windows.
Con questo software si possono realizzare lavori splendidi, di qualunque genere, come un 
semplice oggetto 3d, un'animazione, un gioco, perfino un intero film. Con la versione 2.5 è 
stato raggiunto un nuovo standard qualitativo che porta questo software ad essere forse il  
primo della sua categoria.
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FINESTRA PRINCIPALE

Si comincia. Appena lanciato il programma ecco cosa apparirà di fronte a voi. Questa è la 
finestra principale di  Blender.  A poco a poco arriveremo a conoscere buona parte  dei 
menu. Per prima cosa partiamo dal cubo al 
centro che viene messo in automatico, con a 
destra la lampada e sinistra la telecamera.
Per capire un po' meglio il termine 3d basta 
posizionare  il  puntatore  nella  schermata 
centrale  e  tenendo  premuto  il  pulsante 
centrale del mouse spostare leggermente lo 
stesso.  
L'immagine si ruoterà e noterete che è come 
il  mondo  reale.  State  ruotando  davvero 
attorno ad un oggetto!!!.
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INQUADRATURE FONDAMENTALI

Come  si  fa  a  cambiare 
inquadratura?  Niente  di  più 
semplice.
Per  l'inquadratura  dall'alto  dal 
tastierino  numerico  premete  il  
7. Ed ecco il risultato:

Per l'inquadratura frontale premere (sempre dal tastierino) il pulsante 1:
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Infine per l'inquadratura laterale premere il tasto 3:

Queste  tre  sono  le  inquadrature  fondamentali,  quelle  che  userete  sempre,  qualunque 
lavoro facciate. Premendo altri numeri dal tastierino avrete altre inquadrature.
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AGGIUNGERE OGGETTI

Per selezionare un oggetto basta cliccarci  sopra con il  tasto 
destro  del  mouse,  Quando  un  oggetto  è  selezionato  i  suoi 
contorni diventano arancioni. Ora selezionate il cubo e premete 
il  tasto  x apparirà  un  menu  e  cliccando  sulla  voce  Delete 
verranno eliminati gli oggetti selezionati. Andate nel menu Add 
e poi  su Mesh, apparirà l'elenco degli oggetti inseribili.

Cominciamo dalla prima voce. Cliccando su Plane verrà inserita una figura piana.
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Ora provate con le altre voci:

Cube: per inserire un cubo;

Circle:  per inserire un cerchio (circonferenza).  Dalla voce  Vertices 
(sulla  sinistra) è  possibile  selezionare  il  numero  di  vertici  che  lo 
compongono,  con  Radius invece  si  aumentano  le  dimensioni  del 
raggio. Selezionando il pulsante Fill il cerchio sarà chiuso.

UVSphere: voce dedicata all'inserimento di una sfera. Con  la voce 
Segments si  cambia  il  numero  di  divisioni  verticali,  con  Rings le 
divisioni orizzontali.

IcoSphere: una Icosfera è una sfera formata da facce triangolari.

Tube: per inserire un cilindro. 

Cone: per inserire un cono.

Grid: voce per inserire un piano suddiviso varie volte, praticamente una griglia.

Monkey: simpatica funzione per inserire la mascotte di Blender.

Torus: selezionando questa voce avremo una circonferenza chiusa, come la gomma di 
una moto, o come una ciambella.
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SPOSTARE, SCALARE E RUOTARE

Bene,  ora  ripartiamo  dalla  schermata  principale 
selezionando File>New.
Con il cubo selezionato premete il tasto G e muovete 
il mouse. Ecco che il cubo si sposta.
Come sempre tasto sinistro  per confermare e tasto 
destro  per  annullare.  Se avete confermato e volete 
tornare indietro basta usare Ctrl-z.
Come si sposta una mesh lungo un solo asse?

Spostare una mesh lungo l'asse z:
Selezionate  il  cubo  e  premete  in  successione  G e  Z,  apparirà  una  linea  blu,  se  ora 
muovete l'oggetto si sposterà solo in verticale.

Spostare una mesh lungo l'asse x:
Selezionate il cubo e premete in successione G e X, in questo caso apparirà una linea 
rossa.

Spostare una mesh lungo l'asse y:
Selezionate il cubo e premete in successione G e Y, in quest'altro caso apparirà una linea 
verde.

8



Per scalare un oggetto il procedimento è lo stesso dello spostamento ma in questo caso 
invece del tasto G useremo il tasto S.
Quindi le varie combinazioni saranno:

S+Z per scalare lungo l'asse z;

S+X per scalare lungo l'asse x;

S+Y per scalare lungo l'asse y.

Stessa cosa vale per la rotazione, ma in questo caso usando il tasto R, quindi avremo:

R+Z: ruota lungo l'asse z;

R+X: ruota lungo l'asse x;

R+Y: ruota lungo l'asse y.
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3D MANIPULATION MODE

Cliccando  sul  pulsante  con  tre  linee  colorate  il  menu  si  espanderà.  Andiamo  ad 
analizzarlo.

Quando è selezionata la freccia appaiono delle frecce di tre colori. 
Blu per l'asse z (altezza), Rosso per l'asse x (larghezza), Verde 
per l' asse y (profondità) . Se si si tiene premuto il tasto sinistro del 
mouse su una delle frecce e si trascina l'oggetto si sposterà nella 
direzione di quella freccia. Per esempio se si tiene premuto il tasto 
sinistro sulla freccia blu e si trascina l'oggetto verrà spostato lungo 
l'asse z.

Se invece della freccia si seleziona il pulsante che raffigura una 
curva apparirà la seguente figura. 
In  questo  caso  se  si  seleziona  una  delle  linee  colorate  e  si 
trascina l'oggetto verrà ruotato lungo quell'asse.

Quando  ad  essere  selezionata  è  la  freccia  con  punta  quadrata 
riappariranno le frecce ma con la parte finale quadrata. In questo 
caso possiamo scalare l'oggetto.

Volendo i  valori  di  ingrandimento,  spostamento e rotazione possono essere inseriti  da 
tastiera.  Per  esempio  se  vogliamo ruotare un oggetto  di  45 gradi  lungo l'asse z,  non 
dobbiamo fare altro che selezionarlo, premere R>Z e  scrivere 45.
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OBJECT MODE – EDIT MODE

In basso troverete la scritta Object Mode,

quando ci  si  trova  in  questa modalità  un oggetto  può essere  modificato solo  nel  suo 
insieme, non possono essere modificati i singoli vertici. Generalmente si usa la modalità 
Object Mode per ruotare, scalare o spostare un oggetto. 
Per 'modellare' un oggetto si deve entrare in modalità Edit Mode.
Se aprite il menù vedrete che ci sono varie modalità di utilizzo.
Per ora concentriamoci su queste due.

Ora selezionate il cubo per entrare in modalità  Edit Mode premete il tasto  Tab. Il  cubo 
apparirà con il contorno arancione e le facce di un marrone chiaro e saranno riconoscibili i 
vertici. 
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Selezionate un vertice, poi premete il tasto  G e spostate il vertice muovendo il mouse, 
tasto sinistro per confermare. Poi tornate in modalità Object Mode sempre con il tasto Tab. 
Dovreste ottenere un risultato simile all'immagine qui sotto.

Se ora tornate in Edit Mode (tasto Tab), sarà selezionato solo il vertice che avete utilizzato 
prima. Per selezionare o deselezionare tutti i vertici velocemente basta usare il tasto A. Se 
ora lo  premete si  deselezionerà tutto,  se lo  premete  un'altra  volta  avrete tutti  i  vertici 
selezionati.
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E se volessimo selezionare solo i vertici al centro?

Andate nell'inquadratura dall'alto (tasto 7) e deselezionate i vertici (tasto A).

Adesso  se  premete  il  tasto  B intorno  al 
puntatore  appariranno  dei  prolungamenti. 
Adesso tenendo premuto il  tasto  sinistro  del 
mouse disegnate un quadrato attorno ai vertici 
centrali come nella figura sotto.

Ora  se  lasciate  il  tasto  sinistro  avrete 
selezionati i vertici all'interno dell'area scelta.

Se provate a compiere la stessa azione di prima attivando questo pulsante  potrete 
notare che verranno selezionati  solo  i  vertice superiori,  perché questo pulsante 
rende invisibili i vertici che si trovano dietro.
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SUDDIVIDERE E AGGIUGNERE VERTICI

Ora  cominciamo  un  nuovo  lavoro  (File>New),  cancelliamo  il  cubo  (X>Delete)  e 
aggiungiamo un piano (Add>Mesh>Plane).  Per rendere invisibili le facce e poter vedere 
bene i vertici utilizziamo la funzione Wireframe.

Adesso il nostro piano è formato da quattro vertici.  Vediamo come aggiungerne altri. Con 
tutti i vertici selezionati premiamo il taso  W, dal menù che apparirà occorre selezionare 
Subdivide. Il piano adesso avrà 9 vertici. Se ripetete un'altra volta l'azione ne avrà 25.
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Ora analizziamo altri due modi per aggiungere vertici.

Torniamo al nostro piano di base (4 vertici) con Ctrl+Z.
Sempre in Edit Mode premiamo in successione Ctrl+R e muoviamo il mouse all'interno del 
piano,  noteremo che comparirà  una  linea viola  o  verticale  o  orizzontale,  in  base  allo 
spostamento che compiamo.

Se premiamo il tasto sinistro del mouse la linea diventerà gialla e potremo spostarla nel 
punto in cui vogliamo dividere, naturalmente poi si deve confermare la scelta (tasto sinistro 
del mouse). 

Se si selezionano due vertici (tasto Shift premuto e tasto destro del mouse per scegliere i 
vertici) e si seleziona Subdivide verrà applicato un vertice solo tra i due scelti.
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ESTRUDERE

Una delle cose che farete di più sarà quella di estrudere le varie parti di un oggetto.
Vediamo come fare. Per prima cosa torniamo al nostro piano di base. Poi selezioniamo 
due vertici consecutivi. 

Una volta fatto questo premete il tasto E e spostate il mouse.  Adesso abbiamo estruso le 
parti selezionate. Per estrudere precisamente dopo aver premuto il tasto E vanno digitate 
le varie combinazioni  viste precedentemente per spostare gli  oggetti.  Per esempio per 
estrudere verticalmente si preme E, poi G>Z e si sposta.
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AGGIUNGERE FACCE

Se volete che dei vertici siano i contorni per una faccia potete risolvere il problema in un 
modo molto semplice. Per vedere come fare partite da un nuovo lavoro ed entrate in Face 
Mode e Selezionate la faccia superiore del cubo. Una volta selezionata premete il tasto X 
e selezionate dal menu Only Face, in questo modo eliminerete la faccia ma non i vertici.

Tornate in  Vertex Mode. Adesso vogliamo creare una faccia partendo dai quattro vertici 
che abbiamo selezionati. Con i vertici selezionati premete il tasto F, ed ecco fatto, la faccia 
è stata creata.

Questo procedimento va bene se abbiamo massimo quattro vertici. Vediamo come fare 
con figure più complesse. 
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Selezionate il  vertice a sinistra ed estrudetelo come nell'immagine seguente. Una volta 
fatto questo selezionate i vertici che non sono uniti e per farlo premete anche questa volta 
il tasto F.

Se adesso selezionate i cinque vertici che non formano una faccia e premete il tasto F non 
accadrà nulla.  In questo caso (più  di  4 vertici)  dovete usare la  combinazione  Shift+F. 
Provate ed otterrete questo risultato.
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CAMBIARE COLORE E ASSEGNARNE UNO PER OGNI FACCIA

Adesso aprite un nuovo lavoro, inserite un piano 
e  dividetelo  due  volte,  poi  tornate  in  Object 
mode. Date un'occhiata al menu Material. 

Per  prima  cosa  assegnate  un  materiale  a 
tutto  l'oggetto  facendo  click  sul  pulsante 
New. Il piano ora è diventato grigio. Facendo 
click  nel  riquadrino  grigio  sotto  la  voce 
Diffuse si  aprirà  una   finestra  dalla  quale 
potrete cambiare colore. 

Per assegnare un colore ad ogni faccia dobbiamo entrare in modalità  Edit Mode (Tasto 
Tab)  e  selezionare  il  pulsante  Face  Select  Mode che  permette  di  visualizzare  e 
selezionare le facce di un oggetto.
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 Cliccate sul + per creare un nuovo materiale

Il programma crea una copia del materiale precedente. Per differenziare il secondo dal 
primo dovete cliccare sul + che si trova accanto al nome.

Adesso il nome cambierà in Material.001. 

Cambiate il colore ed ecco cosa vedrete. Adesso avete due materiali di differente colore.

Selezionate una faccia.

Facendo click su Assign assegnerete il materiale alla faccia selezionata.  
 

Ecco come appare ora il piano. Continuando potete colorarlo di un colore per ogni faccia.
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CREARE GRUPPI DI VERTICI

Nel menu  Object Data troviamo la funzione  Vertex Groups,  che permette di creare dei 
gruppi di vertici, una cosa davvero molto utile quando si creano figure complesse. 

Fate click sul pulsante New. Apparirà la voce Group. Cambiamola in primogruppo.

Adesso in Edit Mode e con la visualizzazione per vertici 
selezioniate  quelli  che volete  far  appartenere al  gruppo.  Una volta  selezionati  i  vertici 
basta fare click su Assign per creare il gruppo.  Adesso se provate a cliccare su Deselect e 
poi su Select vedrete che i vertici scelti verranno selezionati e deselezionati.
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UV MAPPING

Allargate  la finestra sottostante la visuale 3D. Selezionate dal menu 
la voce UV/Image Editor.

Adesso selezionate la faccia del cubo che volete mappare. Premete il tasto U, apparirà un 
menu  dal  quale  dovete  selezionare  Unwrap.  Ora  nella  schermata  dell'UV apparirà  la 
proiezione della faccia selezionata.

Nella barra sottostante cliccate su Image e poi su Open. Si aprirà la finestra per cercare il 
file da caricare. Caricate un'immagine. 
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Una volta caricata l'immagine tornate in Object Mode e dal menu Draw Type selezionate la 
voce Textured. Così potrete vedere il risultato direttamente dalla schermata di lavoro.
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RENDER

Aprite un nuovo lavoro e premete F12. Ecco il vostro primo render.

Proviamo a modificare alcune voci del materiale e del mondo per vedere gli effetti con il 
render. Per prima cosa vogliamo che il  nostro “cielo” sia azzurro. Vediamo come fare. 
Entriamo nelle proprietà del mondo. Nel sotto-menu World trovate la voce Horizon Color, 
cliccate  sulla  casella  grigia  e  cambiate  il  colore  in  azzurro.  Nella  schermata  Preview 
potrete vedere l'anteprima.

Adesso provate a rieseguire il  Render (F12). Lo sfondo sarà del colore selezionato. Ma 
adesso vogliamo che il  nostro cielo sia sfumato. Per fare settate le impostazioni come 
sotto:
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Ecco com'è adesso l'anteprima del cielo. Provate a fare il  Render e vedrete il  risultato 
finale.

Ora possiamo concentrarci sugli oggetti. Applicate un piano sotto il cubo, come se fosse il 
pavimento sul quale poggia l'oggetto. Scalate il piano. Per attaccarlo al cubo andate nella 
visuale frontale o laterale per spostarlo verticalmente aiutatevi con il tasto CTRL, in questo 
modo si attaccherà alla parte inferiore del cubo.

Aggiungete  un  materiale  al  piano  dal  menu  Material  selezionando  la  voce  New e 
assegnateli un bel verde. Ecco il render:
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Selezionate il cubo e andate nel menu Material. Ora entrate nella sezione Transparency e 
impostate come segue. Accanto potrete vedere come verrà l'anteprima.

Fate di nuovo il Render. Il cubo è trasparente.

Spostate un po' il cubo lungo l'asse y in modo da averlo nella visuale della telecamera un 
po'  più  a  destra.  Ora  aggiungete  un  piano  verso  la  parte  superiore  del  pavimento  e 
ruotatelo di 90 gradi. Dovreste ottenere un risultato come questo.
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E' arrivato il momento di far diventare il nuovo piano uno specchio. Per prima cosa andate 
nel menu Material, il piano non ha ancora un materiale assegnato, fatelo. Qui sotto sono 
riportate le impostazioni per renderlo uno specchio.

Se adesso fate il Render ecco cosa otterrete:

Una delle funzioni più importanti  del  Render e l'Ambient Occlusion. Questa funzione è 
stata  studiata  appositamente  per  i  programmi  di 
grafica  3d.  Per  prima  cosa  togliamo la  luce  alla 
nostra  lampada.  Per  fare  ciò  selezionatela  e 
andate nel menu Object data. Per togliere energia 
alla lampada azzeriamo la voce Energy.   
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Se adesso eseguite il render l'immagine sarà, a parte il cielo, tutta nera.

Ora andremo a provare l'ambient occlusion. Andate nel menu World e selezionate la voce 
Ambient Occlusion. 

Eseguite il render. L'immagine sarà molto più reale rispetto alla normale lampada però se 
avete notato l'immagine non è ben definita....vediamo come migliorarla.

Se date un' occhiata sotto la scritta Ambient Occlusion troverete  la scritta Samples. Il suo 
valore va da 1 a 32. Più l'aumentate più il render sarà perfetto, per contro avrete dei tempi 
più lunghi. Se non avete un PC molto potente non usate valori troppo alti.
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Render con Samples a 5.

Samples 10.

Samples 15.
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MENU RENDER

Per  gestire  le  opzioni  di  Render esiste  un  menu 
apposito.  Da questo menu si  possono gestire varie 
opzioni,  dalla  risoluzione,  alla  qualità  al  tipo  di  file 
etc...
Vediamo  quelli  più  importanti.  Nella  sezione 
Dimension  è  possibile  cambiare  la  risoluzione 
dell'immagine sotto la voce Resolution. Sotto la voce 
Frame  Range è  possibile  scegliere  da  che  frame 
(inizio) a che frame (fine) volete che sia renderizzato 
il  lavoro.  Questa  funzione è molto  importante per  i 
filmati. Un'altra voce importante, sempre per i filmati è 
FPS  (Frame  per  secondo),  sotto  Frame  Rate.  Il 
numero 24 sta ad indicare che la velocità del filmato 
sarà di 24 frame al secondo. Più sotto si trova la voce 
Anti-Aliasing  (anti-scalettatura),  disattivandola 
l'immagine verrà di bassa qualità con i contorni non 
precisi  e  la  qualità  delle  ombre  approssimativa.  Il 
valore di default 8 è un valore medio ma molto buono. 
Aumentandolo i tempi di render si allungheranno.
Nella sezione Output è possibile scegliere la cartella 
nella  quale  verranno  salvati  i  render  ed  il  formato 
degli stessi.
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CAMBIARE RISOLUZIONE

Utilizzando lo stesso lavoro precedente vediamo come cambiare risoluzione all'immagine. 
Se andate nell'inquadratura 0, cioè quella della telecamera vedrete che l'area in chiaro è 
questa:

Andate nelle impostazioni di Render, dove troverete la voce Resolution. Quella standard è 
di  1920x1980 pixel,  cambiatela in 800x600. Ora l'area visibile della telecamera si  sarà 
allargata.
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LUCI

In  Blender  ci  sono vari  tipi  di  luci  da  poter  utilizzare,  per  poter  simulare  i  vari  tipi  di 
illuminazione. Nell'immagine sopra è stato usato il tipo Spot, che imita un faro. Andiamo a 
conoscere  i  tipi  di  luce.  Se  selezionate  la  lampada  e  andate  nel  menu  Object  data 
troverete le seguenti voci: 

Ecco le differenze tra le luci:

Point:  Selezionando  questa  opzione  la  nostra  lampada  emetterà  una  luce  in  tutte  le 
direzioni  sempre  con  la  stessa  intensità.  Con  la  voce  Energy è  possibile  scegliere 
l'intensità della luce.

Sun:  Imita  la  luce  solare.  E'  possibile  scegliere  la  direzione  dei  raggi  semplicemente 
ruotando la lampada.

Spot: Date un'occhiata all'immagine sopra. Questo tipo di luce imita una torcia, o un faro. 
E' possibile rendere visibile la scia di luce selezionando la voce Halo nel sotto-menu Soft  
Shape. Ecco la stessa immagine di sopra ma con questa funzione attiva:
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Hemi: Questo tipo di luce serve a imitare la luce proveniente dal cielo. Infatti ha una forma 
semisferica, come la volta celeste. Come per la luce di tipo  Sun è possibile scegliere la 
direzione dei raggi. 

Area: Con la luce di questo tipo possiamo imitare oggetti o superfici che emettono una 
luce, come un televisore, o un Led. Le ombre più leggere rispetto a una normale lampada.

Sfera con luci di vario colore.
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PRIMA ANIMAZIONE

Adesso vediamo come creare una piccola animazione. Nella finestra in basso aprite il 
Graph Editor. I numeri a scalare che vedete in basso rappresentano i frame. Il numero con 
lo sfondo verde indica il frame in cui ci si trova.

Selezionate il  cubo e premete il  tasto I,  dal  menù che apparirà 
selezionate  Loc.  In  questo  modo  nel  frame  1  verrà  salvata  la 
posizione del  nostro  oggetto.  Il  Graph Editor  ora apparirà  così. 
Sulla  sinistra  possiamo  vedere  che  l'azione  riguarda  il  cubo, 
mentre  le  linee  colorate  rappresentano  gli  spostamenti  dello 
stesso.

Spostiamoci nel frame 50 trascinando la linea verde con il numero 1. Quando siamo nel 
frame 50 spostiamo il nostro cubo in alto e ripetiamo l'azione di salvataggio della posizione 
con I>Location. La linea viola si curverà per rappresentare l'ascesa del cubo. Per vedere il 
movimento spostatevi tra i vari frame trascinando l'indicatore del frame corrente.
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Sopra abbiamo il frame 1, il 25 ed il 50.
Adesso vedremo di aggiungere al movimento del cubo una rotazione di 
360 gradi. Tornate nel frame 1 e con il cubo selezionato premete I (i) ma 
questa volta selezionate la voce Rotation, in modo da salvare la rotazione 
iniziale del cubo. 

Poi andate nel frame 25 e ruotate il cubo di 180 gradi lungo l'asse x. Salvate la rotazione 
(I> Rotation) Adesso nel GraphEditor dovreste avere la linea rossa simile a questa.
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L'ultima cosa da fare è andare nel frame 50, far compiere altri 180 gradi al cubo e salvare 
la rotazione.

Se adesso scorrete i frame il cubo salirà e ruoterà allo stesso tempo. 

Per renderizzare il tutto andate nel menu render e settate queste due impostazioni:

Frame iniziale e finale;

Formato (Avi Raw per filmati di alta qualità).

Ora potete procedere al render cliccando sulla voce Animation.
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SMOOTH & SUBSURF

Altre funzioni utilissime sono quelle che permettono di levigare e arrotondare le mesh. 
Aprite un nuovo lavoro e partendo da un piano create una figura come la seguente:

Adesso andate nel menu Modifiers. Sotto trovate la voce Add Modifier, cliccateci sopra e 
dal menù che appare selezionate Subdivision Surface. Ora la figura sarà così:

Potete notare (in Edit Mode) la differenza rispetto alla figura originale. 
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Adesso aumentiamo il  valore di  arrotondamento.  Nel  menu che è apparso alla destra 
aumentiamo la voce View a 3 (Per avere lo stesso effetto nel render bisogna impostare la 
voce Render allo stesso modo). 

Ecco  com'è ora l'immagine vista lateralmente. 

Per togliere le modifiche basta cliccare, sempre nel menu Subsurf sulla X.

Se non si vuole arrotondare ma si vogliono semplicemente smussare gli spigoli basta far 
click sul pulsante Smooth. Per tornare indietro si deve far click su Flat.

Molto spesso capita di abbinare al Subsurf lo Smooth per ottenere una figura molto liscia.
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CLOTH – VESTITI

Adesso creeremo un filmato di  una tovaglia che cade su un cubo. Questo è possibile 
grazie alla funzione  Cloth, che permette di scegliere anche il tipo di tessuto. Iniziate un 
nuovo lavoro e posizionate un piano  sopra il cubo. Suddividete il piano più volte. Più lo 
suddividete è meglio sarà. Ma è sempre meglio non esagerare per ridurre la pesantezza 
del filmato. 

Con il piano selezionato entrate nel menu Physics.

Selezionate  la  voce  Cloth.  Adesso andremo a  scegliere  il  tipo  di  tessuto.  Cliccate  su 
Presets e selezionate Cotton per simulare il cotone.
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Adesso selezionate il  cubo e, sempre nel menu Physics selezionate la voce Collision. 
Lasciate tutto com'è e tornate al piano.

Sotto  Cloth trovate  Cloth Cache, allargate la voce e cliccate su 
Bake.  Adesso  il  programma  creerà  il  filmato.  Attendete  che 
finisca. Ora se scorrete i  Frame potrete vedere il  filmato. Il  piano cadrà sul  cubò e si 
piegherà come una coperta. Aggiungete il Subsurf al piano di valore 2 più lo Smooth. 
Ecco alcuni fotogrammi:
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PARTICEL 
 CREAZIONE DI UN PRATO

Aprite un nuovo lavoro, cancellate il cubo e inserite un piano.

Create  una copia del  piano cliccando sulla  voce  Duplicate che si 
trova  nel  menu  alla  vostra  sinistra.  Per  mantenere  la  stessa 
posizione dell'altro piano una volta duplicato premete il tasto destro 
del mouse.

Andate nel menu Particel e aggiungete un sistema 
di particelle cliccando sul +

Il  primo  passo  da  compiere  è  quello  di  selezionare  il  tipo  di  particelle  che  vogliamo. 
Dobbiamo creare dei fili d'erba quindi selezioniamo Emitter e cambiamolo in  Hair, infatti 
useremo lo stesso metodo usato per creare i capelli.
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Un po'  più sotto c'è la voce  Amount che dovete cambiare in 10000. Praticamente ora 
avremo 10000 fili d'erba.

Da  ora  è  importante  tenere  la  schermata  un  po'  ruotata,  va  benissimo l'inquadratura 
frontale, questo solo per vedere in diretta i risultati di quello che faremo ora. Nel menu 
Particel andate in Velocity e cambiate le impostazioni come le seguenti notando bene ogni 
volta il cambiamento compiuto dai fili d'erba.

Una volta inseriti i dati il prato sarà come questo.
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PARTICEL 
 CREAZIONE E MODELLAZIONE DI CAPELLI

Ora  andremo  a   vedere  passo  per  passo  come  creare  dei  capelli  come  quelli  veri. 
Partiamo da un nuovo lavoro ma questa dobbiamo avere davanti solo una sfera, quindi 
dopo avere cancellato il cubo selezionate dal menu  Add>Mesh>UVSphere e andate nella 
visuale laterale o frontale (dal tastierino 1 o 3).

Entrate in Edit Mode e selezionate i vertici similmente all'immagine sotto. Tenete conto che 
la sfera in questo caso rappresenta la testa. Una volta selezionati i vertici andate nel menu 
Object Data e create un gruppo di vertici. Fate clic su Assign in modo da far appartenere i 
vertici selezionati al gruppo. Chiamatelo Hair.
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Una  volta  creato  il  gruppo  tornate  in  Object  Mode e  questa  volta 
entrate nel menu Particel. Aggiungete un nuovo sistema di particelle di 
tipo Hair. Ora la sfera apparirà con dei capelli in tutte le direzioni ma 
noi vogliamo che gli  abbia solo nel gruppo di vertici. Vediamo come 
fare.

Nella parte inferiore del menu Particel trovate 
la  voce  Vertex  groups.  Allargate  il  menu  e 
dove trovate la voce Density scrivete il nome 
del  gruppo  (Hair).  Una  volta  immesso  il 
gruppo  di  vertici  i  capelli  partiranno  solo 
dall'area scelta.
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L'ultima cosa che ci resta da fare è l'acconciatura, infatti Blender permette di modellare i 
capelli, di allungarli, di tagliarli...praticamente di tutto. La cosa che interessa ora a noi è 
modellarli,  quindi,  mettiamoci  all'opera.  Se aprite  il  menu  Mode,  oltre  a  trovare i  soliti 
Object ed  Edit  Mode troverete  anche  la  voce  Particel  Mode.  Selezionatela.  Ora  sulla 
sinistra, all'interno della  Toolbar apparirà il menu  Brush. Dal menu  Brush selezionate la 
voce Comb. Se adesso andate col mouse nella 3D view il puntatore sarà rotondo. Adesso 
se tenete premuto il tasto sinistro e trascinate i capelli questi ultimi si sposteranno nella 
direzione che volete. Provate a modellare fino ad ottenere il risultato voluto. Controllate 
bene il risultato da tutte le angolazioni per essere sicuri del risultato.

Ecco il nostro personaggio con i capelli sciolti e con la coda. 
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RIMBALZO

Alla fine di questo tutorial avremo il filmato di un cubo che cadendo rimbalza sul piano. 
Partiamo da un nuovo lavoro.

• Aggiungete un piano sotto il cubo e spostate quest'ultimo in alto, come 
nell'immagine  1.

• Selezionate il piano a andate nel menu Physics.

• Attivate la voce Collision per fare in modo che il piano non sia attraversato dal cubo. 
Attivando  la  collisione  il  menu  si 
espanderà.  Andate  nella  voce  Soft 
Body  Damping e  aumentatela  a 
1.000 (il massimo) come nella fig.3.  
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• Adesso è la volta del cubo. Selezionatelo e andate nel menu Physics. Questa volta 
attivate la voce Soft Body. Per fare in modo che il cubo cada disattivate la voce Soft  
Body Goal. Anche la voce Soft Body Collision deve essere disattivata altrimenti il 
cubo non rimbalzerà ma si spiaccicherà sul pavimento. Le altre impostazioni vanno 
lasciate.

• Espandete la voce Soft Body Edge. 
Aumentate la voce Damp a 1 e selezionate Stiff Quads.
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• L'unica cosa  che ci resta da fare è far registrare al programma l'azione. Per fare 
questo allargate la voce Soft Body Cache e fate click su Bake. Aspettate che finisca 
e poi per vedere il risultato muovetevi lungo la Timeline.

• Se volete salvare il filmato basta scegliere dalla sezione Output del  Menu Render 
un formato video e poi fare il Render.
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DIVIDERE LE FINESTRE

Osservate bene l'immagine sotto. Ci sono ben 4 schermate per vedere il nostro oggetto ed 
ognuna con un'inquadratura differente. Chi ha già usato Blender o altri programmi simili sa 
bene che poter controllare una mesh da più angolazioni è una cosa molto importante. 
Come si fa ad ottenere questo? E' proprio quello che vedremo ora.

Aprite un nuovo lavoro. Sulla parte destra si trova la Toolbar. 
Se passate il puntatore sul bordo della finestra il puntatore 
cambierà e presenterà due punte. Adesso potete trascinare 
la barra fino a farla sparire. Un metodo più semplice è quello 
di andare nel menu View e selezionare la voce Toolbar. Per 
riattivarla basta compiere la stessa azione.

49



In alto a destra della  3d view, accanto al tondino con il + (serve ad aprire la barra delle 
proprietà), troverete delle righe  oblique. Se andate con il mouse sopra di esse diventerà a 
forma di croce. Tenete premuto il tasto sinistro e spostavi a sinistra. Ecco che si creerà 
una nuova finestra. 

In  questo  modo  avete  diviso  la  vostra 
schermata  verticalmente.  Per  dividerla 
orizzontalmente  ripetete  l'azione 
precedente  ma  questa  volta  trascinate  il 
puntatore verso il  basso.  In  questo modo 
avrete  divisa  una  finestra  anche 
orizzontalmente. Per avere quattro divisioni 
compiete  l'azione  anche  per   l'altra 
schermata  che  ora  è  ancora  grande. 
Adesso  se  cambiate  la  visuale  in  una 
finestra si cambierà solo in quella, in modo 
da poter avere una visuale diversa per ogni 
finestra. 
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TEXTURE

Per  creare  materiali  realistici,  come  il  metallo  il  legno  e  tanti  altri,  Blender  offre  la 
possibilità di usare delle  texture. Imparare a usarle bene è molto importante. Andiamo a 
conoscerle.  Accanto alla sezione dei  materiali  si  trova l'icona che interessa a noi.  Per 
parlare delle texture non basterebbe un libro intero quindi una volta che conoscerete i tipi 
di  texture utilizzabili  sta a voi  provarle  e trovare le  combinazioni  che più  vi  sembrano 
interessanti.

Entrando  nel  menu  texture potrete 
vedere  l'elenco  di  texture applicate 
all'oggetto. Quando inserite un nuovo 
oggetto questo non ha alcuna  texture 
applicata.  Una  volta  che  avete 
applicato  un  materiale  basta  andare 
nella  sezione  texture e  assegnarne 
una selezionando la voce Add.

Ecco l'elenco delle texture disponibili:

Wood: Texture per riprodurre il legno;

Voxel Data: Un voxel è un pixel tridimensionale. 
Questa  funzione  permette  di  realizzare  fluidi  o 
fumo,  ma  anche  movimenti  etc.  facendo 
risparmiare memoria al computer e permettendo 
di gestire meglio i valori;

Voronoi: Per creare metalli realistici, ma anche 
per  altre  necessità,  come,  ad  esempio,  i  vetri 
colorati di una chiesa;

Stucci:  Da  usare  per  superfici  ruvide  come 
l'asfalto;

Point Density: nuova funzione da utilizzare per i 
sistemi  particellari.  Per  visualizzare  la  densità 
delle particelle.

Plugin: Imposta la texture caricando file scritti in 
linguaggio C;
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Noise: Utilizzabile per materiali ruvidi;

Musgrave: Per diversi utilizzi come pietre particolari, ma anche oro e metalli;

Marble: Per riprodurre il marmo;

Magic: Ricrea i riflessi in stile arcobaleno come quelli di un Cd;

Image or Movie:  Per applicare un'immagine o un filmato al  materiale.  Molto utile per 
creare render realistici, ad esempio quelli architettonici;

Environment Map: Per rendere più complesse e realistiche le riflessioni;

Distorted Noise: Utilizzabile per varie cose, come ad esempio l'acqua;

Clouds: Per materiali irregolari, distorti, come le nuvole o il fumo;

Blend: Usata per creare sfumature particolari o per mischiare altre texture.

Effetto cartoon realizzato con la texture Wood.
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WEIGHT PAINT

Blender  offre  la  possibilità  di  selezionare  la  parte  dell'oggetto  che  c'interessa 
semplicemente  passandoci  il  mouse sopra,  come se  usassimo una bomboletta  spray. 
Aprite un nuovo lavoro e suddividete il cubo varie volte. 

Adesso dal menu  Mode  selezionate la voce  Weight Paint.  Il cubo diventerà blu e sulla 
sinistra si aprirà il menu per le varie impostazioni della modalità scelta. 

Lasciate  tutto  com'è  e  concentratevi  sul  cubo.  Se  tenete  premuto  il  tasto  sinistro  del 
mouse e vi  spostate  sul  cubo le  aree  su  cui  passerete  cambieranno colore.  Colorate 
un'area del cubo a piacere e poi tornate in Object Mode.
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Se adesso date un'occhiata nel menu Object Data vedrete che è stato creato un gruppo di 
vertici automaticamente.

Andate in Edit Mode deselezionate tutti i vertici e selezionate solo i vertici appartenenti al 
gruppo col pulsante  Select. Potrete vedere che le parti del cubo appartenenti al gruppo 
sono proprio quelle che avete colorato nel Weight Mode.
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CONCLUSIONE

Questo è una manuale all' “introduzione” di Blender, quindi non pensate che sia finita qua 
poiché lo studio di un software così non finisce mai. Più si va avanti più si apprende. Sul 
nostro portale aggiungeremo periodicamente dei tutorial che potrete consultare in maniera 
gratuita. Ma la cosa importante è che questo software vi darà tantissime soddisfazioni.
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